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Overview

Introduction

This user manual describes how to use the CartWatch for managing your users and
carts.

This user manual is divided into the following chapters:

o Overview: This chapter contains information about the features of your
CartWatch, benefits of using CartWatch and the terms used in the document.

¢ Installing CartWatch Remote management Software: This chapter provides
the steps to install CartWatch Remote management software.

e Logging into CartWatch: This chapter provides the procedures to login and exit
the CartWatch.

e Managing Carts: This chapter provides the procedures for managing your carts
through the CartWatch.

¢ Managing Cart Groups: This chapter provides the procedures for managing
your cart groups through the CartWatch.

e Managing Log Records: This chapter provides the procedures for managing the
log files associated with the carts you manage.

e Managing Users: This chapter provides procedures for managing your users
through the CartWatch.

e Managing User Groups: This chapter provides procedures for managing your
user groups through the CartWatch.

e My Profile: This chapter allows the logged in user to view details and to edit or
update existing details through the CartWatch.

¢ Send Changes: This chapter provides procedures for managing user and cart
details in the actual cart through the CartWatch.

¢ Roles and Permissions: This chapter provides procedures for granting the
general access privileges to any user and for further restricting access to user
roles in the CartWatch.

e Import and Export Users: This chapter provides procedures for importing and
exporting users into the application through the CartWatch.

o Activate Users: This chapter provides procedures for activating the deleted
users into the application through the CartWatch.
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Overview
o Activate Carts: This chapter provides procedures for activating the deleted carts
into the application through the CartWatch.

o Failed User Update: This chapter provides procedure for viewing the details of
the failed users through the CartWatch.

o Failed Cart Update: This chapter provides procedure for viewing the details of
the failed carts through the CartWatch.

e System Settings: This chapter provides procedure to change the system
settings through the CartWatch.

e Trouble Shooting: This chapter provides basic troubleshooting tips to follow
when working with your carts.

Documentation Conventions

o Highlighted Bold Text indicates field names, column names, Command
names, screen names, image captions and the messages.

e --->Denotes navigational path to the menu and submenu
e The term alphanumeric means a combination of letters and numbers.

e The term special character describes characters as follows:! @#$%"&*+_= .

Introduction to CartWatch™ Remote Management Software

What Is the CartWatch™ Remote Management Software?

The CartWatch enables you to manage multiple carts from one workstation through remote
technology instead of requiring you to have direct access to each cart individually.

The software is comprised of three components:
1. Manage Carts
e Manage Cart
e Manage Cart Group
e View Log Files
2.Manage Users

e Manage User

e My Profile
e« Manage User Group
3.Update

e Send Changes
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Overview

Benefits of Using CartWatch

The CartWatch enables you to read information from the cart and remotely manage the cart
settings and user settings from one location.

The benefits of using the CartWatch include:

The ability to manage multiple carts by making changes to all simultaneously instead of
to each cart individually.

Increased speed in performing tasks, such as adding users and changing cart settings.
Improved security by enabling faster updates to carts and user settings.
Greater flexibility enabled by wireless technology to make updates.

Use of groups to enable greater management over large numbers of carts/users.

After the software is installed and set up, administrator can connect remotely to the carts to
manage user and cart settings, and to read log records. Administrators can also use the software
to change, add, or delete users and cart settings and then apply (write) any data changes to the

cart.

Log, User, and Cart Settings Records

The CartWatch uses three types of records to manage the cart's data. The types of records are:

Event Log Record: An event log record is a read-only record that contains events that
occurred on the cart. You can use the sorting feature in the View Log Records window to
sort events by type or date, or print the log record, depending on your requirement.

User Record: A user record contains user profile and access information to access the
cart. You can manage user information on the cart, make changes to the user profile, and
send all the changes to the cart.

Cart Settings Record: A cart settings record contains all of the settings on the cart. You
can read settings from the cart, manage cart information in the database, can make
changes to the cart settings, and send the changes to the carts.

Terms and Definitions

This list describes general terms used in this document.

Access Card— An optional card-swipe feature that can be used as an additional security
requirement or as the primary cart access method.

Access Code—A four-, five-, or six-digit personal identification number (PIN) that
provides cart access. This code can be General (one access code per cart) or Specific
(one access code per authorized user or group of users). The default value is four (4).

Cart Settings Record—A record that is used with the CartWatch. This record contains
information about cart settings.

Group of Carts—An administrative category used to define a set of carts that have a
common characteristic, such as a common setting or a common physical location that is
used to manage large numbers of carts.
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e Log Record—A record that is used with the CartWatch. This record contains information
about events that occurred on the cart. This record can be saved and exported, but not
modified.

e Master Code—A four-digit numeric code that enables an authorized administrator to
change cart settings or view cart logs.

¢ Narcotic Code—A four-digit numeric code that must be entered before an authorized
user can open any of the locked eNarc narcotics drawers. Available settings are
“General” (one eNarc code per cart) or “Specific” (one eNarc code per authorized user or
group of users) and the following usage rules apply:

o If the access code is set to “General,” the Narcotics Code must be set to General
unless the cart is configured with the access card accessory.

o If the access code is set to “Specific,” the Narcotics Code can be set to either
“General” or “Specific,” depending on your needs.

e Override Code—A four-digit code assigned to the cart that bypasses alarms, timers, and
relocking mechanisms. Typically, this function is used while the cart is being restocked in
the pharmacy.

e Permission—Permissions are the access rights to a specific function in the CartWatch.
Permissions are used to further restrict user access to the functions in the CartWatch.

e Roles—Roles are the level of general access assigned to a user in the CartWatch. For
example:

o Global role—Users who have rights to all functions and can make all changes to the
carts and user settings for all of the carts and users in the database.

o Local role—Users who have access to only a limited number of carts, but can make
all changes related to the carts and users they manage.

e Send Changes—The Send Changes button enables an administrator to apply settings
changes that were made using the CartWatch to the cart.

e User ID—A unique, five-digit number that identifies the person using the cart. Unlike an
access code, a User ID cannot be modified after it is accepted.

e User Record—A record that is used with the CartWatch. This record contains user
profile information and can be modified.

Roles and Responsibilities
Users in the CartWatch are assigned access privileges based on job function. User types include:

o Global—This user (typically an IT manager or nursing director) can change all settings or
view all log records on all carts and users in the CartWatch database. This user can
access all areas of the cart and user database and is responsible for adding new cart
users, changing cart user profiles, and reading log records from the carts.

o Local—This user (typically nursing manager) can access some or all areas of the cart
and user settings for the carts and users they manage. These permissions are based on
privileges the administrator assigns. A local user typically has a group of carts to manage
such as all the carts on a floor.

Other than predefined roles, you can define new roles and define permissions for them
and then these roles can be assigned to different users.
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Override Rights

Administrators can assign override rights to each user type. Override rights grant users the use of
a special Override Code that is assigned to the cart. The Override Code bypasses the cart’s
alarms, timers, and relocking mechanisms. The override right is typically used while the cart is
being restocked in the pharmacy.

Read From Cart and Send Changes Functionality

The CartWatch Read from Cart functionality enables you to manage log records and settings
from the cart to populate the CartWatch database. If the cart was serviced, the cart and database
settings are synchronized.

The Send Changes functionality enables you to send your changes that you make to a user
record or a cart settings record in the CartWatch database to the cart.
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CartWatch Installation Process

Installation Process Steps
1. Click on the Windows Installer Package, the CartWatch Setup Wizard displays.

Figure 1: CartWatch Wizard
2. Click on “Next” button to proceed on next step or “Cancel” to close or discard the setup

3. After clicking on “Next” button, you have to provide the Database Server
Configuration/Credential used by the CartWatch application. Database Server configuration
details are mandatory to move on to next step.

4. Enter the following information.

Database Server Name: Name of the SQL server where database has to be created.
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Database Name: Name of the database to be created, where all the tables and procedures will

be stored.

User Name: Login name of Database Server (used to get connected with Database
Server).

Pasword: Password of database server for the above login name.

Note: Database Name must be unique, otherwise if the given database name already exists, it
will overwrite the existing database & data will be lost.

Figure 2: Database Configuration

5. You may move to previous screen by clicking on “Back” button, or close or discard the Setup
using “Cancel” button & “Next” button to proceed to next step. “Next” button will be enabled only
after you provide the Database Name, User Name, and Password.

6. After clicking the “Next” button, you will move on to language selection screen of the installing
CartWatch application. You may choose any one language from the listing (English, Spanish,
French) by selecting the respective language radio button, as shown in the below screen shot.
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Figure 3: Project Configuration

You may move to previous screen by clicking the “Back” button, or close or discard the Setup
using “Cancel” button & “Next” button to proceed to next step.

7. After clicking the “Next” you will move on to the Data Migration Screen. This screen is aimed to
migrate your old RMS Application data (data used by the existing/old application, if you are
already using RMS 2.0) to the CartWatch application.

If you want to migrate your old RMS application data into the new installing CartWatch
application, you need to check the Check box, showing with the caption “Do you want to migrate
your old data into new database” & also need to provide the name of existing RMS application's
database from which data has to be migrated into new database.

If you would not check the migration check box, the installing CartWatch application will have a
fresh database & will not incorporate old RMS application data.
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Figure 4: Database Migration

You may move to previous screen by clicking the “Back” button, or close or discard the Setup
using “Cancel” button and “Next” button to proceed to next step.

8. After clicking the “Next” button, next step will allow you enter the name & location (on hard drive)
of the CartWatch application to be installed. The details of fields to be entered are as follows

Site: - It is a read only name, used for some internal operation to create a virtual directory.
Disk Cost button allows you to check the available & required disk space for all drives on
your system.

Virtual Directory: - Virtual directory will be the name of installing CartWatch application.
Physical Location: - It is the path of application where all the related files are stored on your
hard drive. You can browse & choose any location where you have to install the CartWatch
application. If the given folder name does not exists, it will be created automatically & if it
already exists, all the existing contents will be overwrite by the new installation files

You may move to previous screen by clicking the “Back” button, or close or discard the Setup using
“Cancel” button & “Next” button to proceed to next step.
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Figure 5: Select Installation Address

9. Now all the setup instructions are over & system is ready to install the application. You have to
confirm the installation by clicking on “Next” button or you may move to previous screen (if
needed) by clicking the “Back” button.
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Figure 6: Confirm Installation
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10. After clicking the “Next” button, the system will start the installation of CartWatch application.
During the installation:-

All the database credentials will be validated, if found invalid, it will show an error & you
have to start the setup again.

Validate the migration database name, if found wrong, it will show an error & you have to
start the setup again.

Figure 7: Installing CartWatch

11. If everything is right, CartWatch application will be installed successfully on your machine and the
URL will be launched to run the CartWatch application.
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Figure 8: Installation Completed
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CartWatch

Logging into the CartWatch

Procedure
1. Connect to the CartWatch application by typing the URL in the address bar.
For example, http://10.131.10.191/servername/CartWatch/WebForms/Login.aspx

2. The User Login screen displays. Enter your User Name and Password provided by
the administrator.

Figure 9: Login Screen
Note:

e User Name is case insensitive. Special characters(#, ",.;,:,},],2,*,*,&, '.@,#,$,%,
-) are not allowed in the User Name.

e Password is case sensitive. Special characters(#, ",.;,:,},],2,*,*. &, |,@,#,$,%, -)
are allowed in the Password.

If you do not enter the UserName and Password and click Login button, the application
displays an alert message "UserName and Password cannot be left blank".

In case, you enter a wrong UserName or a Password, you will get a message "Invalid
UserName or Password".

If there is some technical fault or network issue, you will get a message "Unknown Error
Occurred". You need to contact administrator to resolve issue.

After entering the correct UserName and Password, you are re-directed to the Home
page.
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CartWatch

Exiting CartWatch

Procedure

On the Top right of menu header section, click Log Out. You will be successfully logged
out of the system.
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Managing Carts

Managing Carts Introduction

This functionality is used for the management of carts. It lists all available carts in the system and
provides options to sort, filter, add, edit or delete the carts.

Tasks include:
. Adding single carts
. Adding multiple carts
. Editing cart

3 Deactivating cart

. Assigning cart group

3 Assigning cart to user and groups
J Print

Adding Carts

Introduction

This functionality allows you to add carts. You can add single cart or multiple carts in a range at
one time. This provides you the greatest flexibility in managing your carts and users.

How to Add Single Cart
Complete the following procedure to add single cart to the CartWatch.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click on Cart.

3. The Cart Settings page gets displayed.
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Managing Carts

Figure 10: Cart Settings
4. Click on the Add Cart button at the bottom of the page.

5. The Add/Edit Cart window displays. By default, radio button against Add single cart
is selected.

Figure 11: Add Cart
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6. Enter following details for adding a single cart.

e [P Address: This is the IP address of the new cart. It should be a valid IP
address.(Maximum 16 characters) .For example, 190.1.166.2

Note: Fields marked with an asterisk * sign are mandatory.

e Cart Name: This is the name of the new cart. It should be alphanumeric (alphabetic
letters mixed with numbers). (Maximum 25 characters). For example, TX10
Medserver.

e Cart Group: This list contains cart groups. This is an optional field. If you select any
cart group, new cart will belong to this group.

7. Click on the Next button after entering the details. The CartWatch saves the cart to
the database and you are taken to the next screen Assign Cart to Cart Group
Mapping. For instructions, seeAssign Cart to Cart Group Mapping.

8. You can also click on Close button to close the window. It will ask you." Do you want
to save changes". Press “OK" to Save or “Cancel” to exit without saving. If you click
"OK", it will take you to the Cart Settings page.

Adding Multiple Carts Procedure

Complete the following procedure to add multiple carts at one time to the CartWatch.
Log into the CartWatch.

On the Home page, under Manage Carts tab, click on Cart.

The Cart Settings page gets displayed.

Click on the Add Cart button at the bottom of the page. From the Add/Edit screen, select the
radio button against Multiple Carts. The Add Multiple window displays.

e~
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Figure 12: Add multiple carts

Enter following information in Add multiple carts screen.

o IP Address Range: This is the starting IP address of the cart.
e To: This is the last IP address of the cart.

(IP's to all the carts will be assigned between the start and the last range.)

e Cart Prefix: All new Carts will have cart name as prefix and the number. For
example, TDX1, TDX2, TDX3.

e Cart Group: You can select the Cart Group from the list to which you want to assign
the cart.

Note: The cart number is added to this prefix when you save the carts. For example, if you type
Medication as the Cart prefixes, all carts in the range are named Medication followed by the cart
number (Medication01, Medication02, and Medication03.

Click on the Next button after entering the details. The CartWatch saves the cart to the
database and you are taken to the next screen Assign Cart to Cart Group Mapping. For
instructions, see Assign Cart to Cart Group Mapping.

You can also click on Close button to close the window. It will ask you." Do you want to save
changes". Press “OK" to Save or Cancel to exit without saving. If you click "OK", it will take
you to the Cart Settings page.
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Editing a Cart

Introduction

This functionality is used to modify current cart settings and also to retrieve default or current
settings from the cart. You can modify the settings of a single cart or multiple carts. After you add
a cart to the CartWatch, you can change the cart settings to fit your requirements. Cart settings

may include:
J Cart administrative information
J Cart master and override codes
J User codes
. Alarm and beeper levels
3 Security settings
3 Narcotic settings
3 Communication ports settings

3 Light Timeout setting
There are two ways to change the cart settings in the CartWatch:
. Individual settings in the Cart Settings window.

. Multiple settings in the Cart Settings window.

Individual Settings
Complete the following procedure to change individual cart settings.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart.

3. The Cart Settings page gets displayed. Select the cart that you want to change the settings
on and click Edit Cart button at the bottom of the page.

4. The Add/ Edit Cart page displays.



Managing Carts

Figure 13: Edit Cart

Cart:
o Serial No: This is the serial number of the cart. This is a read-only field and its value cannot
be changed.
e HWIFW Rev: HW/FW Rev also displays current Hardware and Firmware version. This is a
read only field and its value cannot be changed.
e User Count: Number of users currently assigned to this cart. This is a read only field and its
value cannot be changed.
e Name: This is the name of the cart. You can modify the name of the cart. It has to be unique
and it cannot be left blank. (Maximum 25 characters)
e [P Address: You can change the IP address of the cart. (Maximum 16 characters)
Alarm/Beeper:

e Level: This list contains the following options:

o Off

o Low

o Medium
o High

You can select any level depending upon the requirement.
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e Narc 1 Alarm: This option is to enable or disable alarm for Narcotics drawer 1. This option
would be disabled if cart does not have any narcotics drawers in it.

e Narc 2 Alarm: This option is to enable or disable alarm for Narcotics drawer 2. This option
would be disabled if cart does not have any narcotics drawers in it.

e Alarm Enable: This option is to enable or disable alarm.
e Key Beep: This option is to enable or disable beep on key press.
Auto Secure:
o Delay Mins: This option is to specify number of minutes after that cart will be auto secured.
(Maximum 3 digits)

o Delay Secs: The cart will be auto secured after given seconds. (Maximum 2 digits). You can
provide either delay minutes or delay seconds

e MTN detector: This is level of motion detection on cart. Valid values are either Off or 1 to 10.
1is the highest sensitivity and 10 is the lowest.

e Light Timeout: This is time in minutes after which cart lights will be turned off if no activity is
detected for given period of time. (Maximum 3 digits)

Cart Code:

e Cart Master: This is the master code for the cart. (Four digits).
e Cart Override: This is the override code for the cart. (Four digits)...

User Code
Type: This list contains the following two options of User Code:
e General: General means a common access code will be used by all users of the

cart. (four digits)

If you select General, then you can enter your General Code in the given field.

e Specific: Specific specifies that each user will have his\her own access code to login.
If you select Specific then the General Code field becomes disabled.
Narcotics:
e No of Drawers: This list contains the number of drawers available in the
selected cart .Currently it contains the following options:

e None: If you select None, there will not be any narcotics drawer in the cart.
In this scenario all the alarm fields will be disabled.

e One: If you select One, there will be one narcotics drawer in the cart.

e Two: If you select Two, there will be two narcotics drawer in the cart.

Com Port Setup:

e Baud Rate: This is the baud rate for the Com Port. This list contains the
following options:

i. 200
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ii. 2400
iii. 4800
iv. 9600

v. 38400(Default)

Parity: This list contains the following options:

e None(Default)
e Even
e Odd
Data Port: It contains Data Port information.
Stop Bits: It contains information of stop bits setting.

Card Access Only: If you select this option, it specifies that user can access cart through
access card only. User Access code and type will be disabled in this scenario.

If you click on the link click here to read settings from the cart (which appears above the
Alarm Beeper section) the CartWatch application connects to the IP of the given cart and
displays all the information of that particular cart.

If it is unable to connect to the cart, you will get a message “Unable to connect, please try
later.

Make the change by either typing a new value or selecting a new value from the list.

6. Click on the Next button after you finish making changes. The CartWatch saves the
cart to the database and you are taken to the next page Assign Cart to Cart Group
Mapping. For instructions, see Assign Cart to Cart Group Mapping.

7. You can also click on Close button to close the window, it will ask you "Do you want
to save changes”. Press "OK" to Save or Cancel to exit without saving. If you click
"OK", It will take you to the Cart Settings page.
Edit Multiple Carts Simultaneously
Complete the following procedure to change multiple cart settings.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart.

3. The Cart Settings page displays. Select multiple carts for which you want to change the
settings and click Edit Cart button at the bottom of the page.

4. The Add/ Edit cart page displays.
Make the setting changes by either typing a new value or selecting a new value from a list.

8. Click on Next button after making the changes. The CartWatch saves the changes and you
are taken to the next page Assign Cart to Cart Group Mapping. For instructions, see
Assign Cart to Cart Group Mapping.

9. You can also click on Close button to close the window, it will ask you "Do you want to save
changes". Press "OK" to Save or Cancel to exit without saving. If you click "OK", it will take
you to the Cart Settings page.
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Deactivating Cart

Introduction

This functionality allows you to deactivate a single cart or multiple carts:

Procedure
Complete the following procedure to deactivate carts.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart.

3. The Cart Settings page displays. Select the carts that you want to deactivate and click
Deactivate Cart button at the bottom of the page.

4. It will ask for confirmation "Are you sure you want to delete the cart(s) ". If you click Yes,
the selected carts would be deactivated and you get a confirmation message
"Deactivated Successfully".

Assigning Users/User Groups to a Cart

Introduction

You must assign users to a cart for the users to be able to access and use the cart. Users can be
directly assigned to a cart or can be assigned through User Group.

Procedure
Complete the following procedure to assign users to a cart.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart.

3. The Cart Settings page displays. Select the cart that you want to assign to the users or user
groups.

4. The “Cart To User/User Group Mapping” screen displays. It is divided into three vertical
sections.

o User Groups
o Active Users
o Carts
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Figure 14: Cart to User/User Group Mapping

You can drag the User Groups and Active Users to the required carts to which you want to
assign.

5. If you want to assign all the Active Users, select the [ selectall check box and drag them
to the required cart.

Note: If a user\user group is already assigned to a cart and you try to assign it
again the application displays an alert message." User\User Group already exists".

6. Click Close to close the window. It will ask you "Do you want to save changes" Press "OK"
to Save or Cancel to exit without saving.

Assigning a Cart to a Group

Introduction

A group is a category that is used to define a set of carts that has a common characteristic such
as a common group of users or a common physical location. You can use groups to manage
large numbers of carts more easily.
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Procedure
Complete the following procedure to assign a cart to a cart group.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart.
3. The Cart Settings page displays. Select the cart that you want to assign to the cart groups.
4. The “Cart To Cart Group Mapping” screen displays.

Figure 15: Assign Cart to a Cart Group

5. ltis divided into two vertical sections.
e Carts
e Cart Groups

6. You can drag the Carts and assign them to the required Cart Groups.

[] select all

If you want to select all the Carts, select the check box and drag them to the

required Cart Groups.

Note: If a cart is already assigned to a cart group and you try to assign it again
the application displays an alert message." Cart already exists".

7. Click Close to close the window. It will ask you “Do you want to save changes”. Press
"OK" to Save or Cancel to exit without saving.
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Introduction

This functionality is used to print the cart list details like Cart Name, IP address, Serial
Number, Master Code, Override code etc.

Procedure
Complete the following procedure to print the cart details.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart.
3. The Cart Settings page displays.
4. Click on the Print button at the bottom of the page.
5. The application displays the list of the cart details.

6. Click on the Print icon that appears at the top of the page.

7. Click Close to close the window.
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Managing Cart Groups Introduction

Introduction

Cart Group sets the group that the cart belongs to. This functionality is used for the
management of cart groups. It lists all available cart groups in the system and provides
options to sort, filter, add, edit or delete the cart groups.

Tasks include:
e Add cart group
o Edit cart group
e Deactivating cart group
e Assigning cart group
e Assigning cart to user and groups
e Print

Adding a Cart Group

Introduction

This functionality is used for adding cart groups. You have to enter the group name and
group description for adding a new cart group.
Procedure
Complete the following procedure to assign a cart to a group.
1. Log into the CartWatch™.
2. Onthe Home page, under Manage Carts tab, click Cart Group.
3. The Cart Settings page displays.
4. Click on the Add Cart Group button at the bottom of the page.
5. The Add/Edit Cart Groups window displays.
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Figure 16: Add Cart Group

Note: Fields marked with an asterisk (*) are mandatory.

You have to enter the following details for adding cart group.

e Group Name: This is the name of the cart group which you will create.
(Maximum 50 characters).

e Group Description: This is the description about the cart group. (Maximum
100 characters).

6. Click on the Next button after entering the details. The CartWatch saves the cart
group details to the database and you are taken to the next screen Assign Carts to
Cart Groups. For instructions, see Assign Carts to Cart Groups.

7. You can also click on Close button to close the window. It will ask you." Do you
want to save the changes"? Press “OK" to Save or Cancel to exit without saving.
If you click "OK", It will take you to the Cart Settings page.



Editing Cart Group

Introduction

This functionality allows you to edit the existing details of the cart groups. You can edit a
single cart group or multiple cart groups depending upon your requirement.

Procedure
Complete the following procedure to assign a cart to a group.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart Group.

3. The Cart Settings page displays. Select multiple cart groups that you need to modify
and click Edit Cart Group button at the bottom of the page.

4. The Add/Edit Cart Groups window displays.

Figure 17: Edit Cart Group

You can modify the following fields:

e Group Name
e Group Description

2. Click on the Next button after making the changes. The CartWatch saves the
changes and you are taken to the next page Assign Carts to Cart Group Mapping.
For instructions, see Assign Carts to Cart Group Mapping.

on © CartWatchTM Software Product © 2011 Capsa Solutions LLC | Proprietary + L 40
Mkl i Manual Confidential
CAPSASOLUTIONS' :




Managing Cart Groups

3. You can also click on Close button to close the window, it will ask you "Do you want
to save changes" Press "OK" to Save or Cancel to exit without saving. If you click
"OK", it will take you to the Cart Settings page.

Removing Cart Group

Introduction

This functionality allows you to delete cart groups.

Procedure
Complete the following procedure to remove cart groups.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart Group.

3. The Cart Settings page displays. Select the carts that you want to delete and click
‘Remove Cart Group” button at the bottom of the page.

4. It will ask for confirmation "Are you sure you want to delete the Cart Group(s) ". If
you click Yes, the selected cart groups would be deleted and you get a confirmation
message "Removed Successfully".

Assigning Carts

Introduction

This functionality allows you to assign carts to cart groups. You can assign a single cart
or multiple carts to the Cart Groups.

Procedure
Complete the following procedure to assign a cart to a group.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart Group.

3. The Cart Settings page displays. Select the cart groups that you need to assign to
the carts and click Assign Carts button at the bottom of the page.

4. Assign Carts to Cart Group screen displays.
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Figure 18: Assign Cart to a Cart Group

5. ltis divided into two vertical sections.
e Carts
e Cart Groups

You can drag the Carts and assign them to the required Cart Groups.

If you want to select all the Carts, select the [ selectall

the required Cart Groups.

check box and drag them to

Note: If a cart is already assigned to a Cart Group, you cannot assign it again, it displays
a message: "Cart already exists".

6. Click Close to close the window. It will ask you “Do you want to save changes".
Press "OK" to Save or Cancel to exit without saving.

Assigning Users/User Groups to a Cart Group

Introduction

This functionality allows you to assign users and user groups to cart group. You can
assign a single cart or multiple carts to the Cart Groups.
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Procedure
Complete the following procedure to assign users to a cart.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Cart Group.

3. The Cart Settings page displays. Select the cart group that you need to assign to the
USEers or user groups.

4. Assign Users/ User Group to Carts/ Cart Groups screen displays. It is divided into
three vertical sections.

o User Groups
o Active Users

o Cart Groups

Figure 19: Assign Users/User Group to Carts/Cart Groups

You can assign a single user, multiple users or you can select all the users for assigning
it to the cart group depending upon the requirement. You can select the cart groups that
you want to assign and drag them to the required cart groups.

If you want to select all the users, select the [ selectall check box.

Note: If a cart is already assigned to a Cart Group, you cannot assign it again, it displays a
message: "Cart already exists".

7. Click Close to close the window. It will ask you "Do you want to save changes"
Press "OK" to Save or Cancel to exit without saving.
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Managing Log Files

Introduction

This functionality allows you to view the cart logs based on the filter criteria. You can view
the log files on the basis of carts, event types, Date from, Date to, User Name, Time
From and Time To.

Tasks include:
e Save Custom Report
e Delete Custom Report
e Read Logs From Cart
e Print Log Reports

Save Custom Report

Introduction

This functionality allows you to save any report for future reference. It saves the criteria
on the basis of which you have searched the report.

For example, if you have searched the report on the basis of event type and saved that
report with the name Event Macro report. Next time, when you view the Event Macro
report, the parameters on which you had searched the report would be selected on
their own.

Procedure

Complete the following procedure to save custom report.
1. Log into the CartWatch.
On the Home page, under Manage Carts tab, click View Log Files.

2

3. Provide your filter criteria in search section.
4. Click on the Save Custom Report button.
5

Save as Custom Report screen displays.
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Save as custom report

*Report Macro Name :

Figure 20: Save as Custom Report

6. You have to enter the name of the Report. For example, enter the name as
MacroReport. Click Save to save the report. The report would be saved and the
application will display the message "Report saved successfully" and it would be
added in the Custom Macro List.

Next time, when you want to view the report, select the Macro Report from the Custom
Macro list, parameters (cart and the corresponding event type) that you had selected for
this particular custom report would be selected on their own.

Delete Custom Report

Introduction

This functionality allows you This functionality allow you to delete any custom report.

Procedure
Complete the following procedure to save custom report.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click View Log Files.
3. Select the report from the Custom Macro list which you need to delete.

Custom Macro : |Kurt's usage
Macro Report

4. Click on the Delete Custom Report button.

5. The application will display an alert message " Are you sure you want to delete
Custom Report". If you press OK, the selected report would be deleted and you will
get a message "Report deleted successfully” else press Cancel, if you do not want
to delete the report.
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Search Log Files

Introduction

This functionality allows you to search the log files on the basis of Carts, Event Types,
User name, Date From, Date to, Time from and Time To.

Procedure
Complete the following procedure to search the log files based on the user name.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click Log Files.
3. View Log Files screen displays.
4. Select filter criteria from search section.
5

Click on search button to get results in Result section.

Figure 21: View Log Files
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Log from Cart

Introduction

This functionality allows you to view the logs for the selected carts.

Procedure
Complete the following procedure to search the log files based on the carts.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click View Log Files.

3. Select the cart from the cart list for which you want to view the logs or you can select
all the carts by selecting the All check box.

Figure 22: Select Cart

For example, you can select ARTROMICK CART 00 for viewing the logs.
4. Click on the Log from Cart button.

The application will read all the information from the selected carts and will display the
result in the result section. The cart must be online for the communication to be
successful.
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Figure 23: Log from Cart Result

You will be able to view the following information.

e Cart Name

e User Name

e Event Date

e Event Time

e Event Description
Examples:

Event performed by the User Andy on 12/15/2010 at 12:44 PM was 001-Invalid Access
Code entered.

Event performed by the User Andy on 12/15/2010 at 12:43 pm was 003-Cart opened
with key on the selected carts.
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Print Log Reports

Introduction
This functionality allows you to print the log reports by Event type, User type and the Cart
type.
Procedure to print the report By Event type
Complete the following procedure to print the reports By Event type.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Carts tab, click View Log Files.
3. Click on Print button.
4

The Report Group screen displays. Select By Event from the Select Report Group
list.

Figure 24: Select Report Group-By Event

5. Click Next. The report is generated in a tabular format. Automatic grouping would
be done on the basis of Cart Names.

Figure 25: Report
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You will find the following columns in it.

o User Name: It shows the names of the users and the event type which took
place.

o Cart Name: It shows the names of the carts on which the events occurred.
o Event Date: It shows the date on which event took place.
o Event Time: It shows the time when event took place.

6. Click on Export CSV button if you want to open or save the report OR click close to
close the window.

Procedure to print the report By User type
Complete the following procedure to print the reports By User type.

1. Select By User from the Select Report Group list.

Figure 26: Select Report Group-By User

2. Click Next. The report is generated in a tabular format. Automatic grouping
would be done on the basis of Cart Name.

Figure 27: Report on the basis of User type
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You will find the following columns in it.

o User Name: It shows the names of the users and the event type that took place.
e Cart Name: It shows the names of the carts on which the events occurred.

e Event Date: It shows the date on which event took place.

e Event Time: It shows the time when event took place.

e Event Description: It provides the information about the type of events.

7. Click on Export CSV button if you want to open or save the report OR click close to
close the window.

Procedure to print the report By Cart type
Complete the following procedure to print the reports By User type.

1. Select By Cart from the Select Report Group list.

Figure 28: Select Report Group-By Event

2. Click Next. The report is generated in a tabular format.

Figure 29: Report on the basis of Cart Type
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You will find the following columns in it.

e User Name: It shows the names of the users.

e Cart Name: It shows the names of the carts on which the events occurred.
o Event Date: It shows the date on which event took place.

e Event Time: It shows the time when event took place.

o Event Description: It provides the information about the type of events.

For example, User Andy was assigned the cart ARTROMICK 00 and the event
performed by him was Invalid Access Code entered on 2/15/2010 at 12:44pm

8. Click on the Export CSV button if you want to open or save the report OR click
Close to close the window.
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Managing Users Introduction

Introduction

This functionality is used for the management of users. It lists all the available users in
the system and provides options to sort, filter, add, edit or delete the users.

Tasks include:
e Add single user.
e Add multiple users
e Edit users
¢ Deactivating users
e Assigning user group
e Assigning carts and cart groups to users.

e Print

Add a Single User

Introduction

This functionality allows you to add a new user. You can add single user or multiple users
in a range at one time. This provides you the greatest flexibility in managing your users
and carts.

How to Add Single User
Complete the following procedure to add single user to the CartWatch.
1. Log into the CartWatch.
2. Onthe Home page, under Manage User tab, click on User.

3. The User Settings page gets displayed.
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Figure 30: User Settings
4. Click on the Add User button at the bottom of the page.

5. The Add/Edit User window displays. By default, radio button against Add User is
selected.

Figure 31: Add User

6. Enter following details to add a single user.
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Note: Fields marked with an asterisk * sign are mandatory.

e User Name: This is the name of the user. It should be a valid User
Name. (Maximum 25 characters)

o Employee ID: This is the ID of the employee. It should be alphanumeric.
(Maximum 10 digits). For example, Sarika1234.

o Date of Joining: You can select the date of joining by clicking the calendar icon.

o Extended ID: This is the user id of the access card. It should be numeric
(Maximum 16 digits)

o User Type: This list contains the type of users. For example, global, local etc

e Narc Access: This contains list of secure drawers. You can select if Narcotics
access is required and the particular drawer for which you need access.

o Expire Date: You can select the date of expiry by clicking the calendar icon.

o Never Expire: If you select this field, user will never expire.

o Description: you can enter the user profile or any other detail in this area.
(Maximum 500 characters)

e User Group: you can select the user group from the list. User will be assigned to
this group.
e Override: If you need override permission, then this option can be selected.
7. Click on the Next button after entering the details. The CartWatch saves the user to

the database and you are taken to the next screen Assign User to User Group. For
instructions, see Assign User to User Group.

8. You can also click on Close button to close the window. It will ask you." Do you
want to save changes". Press “OK" to Save or Cancel to exit without saving. If you
click "OK", it will take you to the User Settings page.

Adding Multiple Users

Introduction

This functionality allows you to add Multiple Users. Users are created with the “User”
prefix and default password is set for each user.

How to Add Multiple Users
Complete the following procedure to add multiple users at one time to the CartWatch.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click on User.
3. The User Settings page gets displayed.
4. Click on the Add User button at the bottom of the page.
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5. From the Add/Edit screen, select the radio button against Add Multiple Users. Add
Multiple Users window displays.

Figure 32: Add multiple users

6. Enter the following information in Add multiple carts screen.

e No of Users: This is the number of users which you want to add.
o User Type: Select the type of user from the list.

e Narc Access: You can select this option if you need Narcotics access for
a particular drawer.
e Date of joining: You can select the date of joining by clicking the calendar icon.

o Expire Date: You can select the date of expiry by clicking the calendar icon.

o Never Expire: If this option is selected, users will not expire.

o User Groups: Select the user group or multiple user groups from the list. User
will be assigned to these groups.

7. Click on the Next button after entering the details. The CartWatch saves the users to
the database and you are taken to the next screen Assign User to User Group. For
instructions, see Assign User to User Group.

8. You can also click on Close button to close the window. It will ask you." Do you
want to save changes”. Press “OK" to Save or Cancel to exit without saving. If you
click "OK", it will take you to the User Settings page.
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Editing a User

Introduction

This functionality allows you to modify the details of the user. You can modify the details like
username, employee id, User Group, Narc Access, Password, User Type, Override, Extended ID,
Date of joining, Expire Date, Termination Date and the description and if required you can even
reset the access code and Narc code.

Procedure
Complete the following procedure to change individual user details.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click User.
3. The User Settings page gets displayed.
4

Select the user that you want to change the details on and click Edit User button at the
bottom of the page.

5. The Add/ Edit User page displays.

Figure 33: Edit User
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10.

You can edit the following fields:
e User Name
e Employee ID
e Date of Joining
e Extended ID
e User Type
e Password
e Access Code
e Expire Date
e Never Expire
e Termination Date
e Description
e User Group
e Override

Click on the Reset Access Code button if you want to reset the Access Code.
Access code gets refreshed and you get a message "Access Code reset
successfully".

Click on the Reset Narc Code button if you want to reset the Narc code. Narc code gets
refreshed and you get a message "Narc Code reset successfully".

Make the change by either typing a new value or selecting a new value from the list.

Click on the Next button after you finish making changes. The CartWatch saves the cart
to the database and you are taken to the next page Assign User to User Group. For
instructions, see Assign User to User Group.

You can also click on Close button to close the window, it will ask you "Do you want to
save changes". Press "OK" to Save or Cancel to exit without saving. If you click "OK", it
will take you to the Cart Settings page.
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Edit Multiple Users Simultaneously
Complete the following procedure to change multiple users’ details.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click User.
3. The User Settings page displays.
4

Select multiple users through checkbox provided in front of each row and click Edit User
button at the bottom of the page.

o

The Add/ Edit user page displays.

Make the setting changes by either typing a new value or selecting a new value from a
list.

11. Click on the Next button after making the changes. The CartWatch saves the changes
and you are taken to the next page Assign User to User Group. For instructions, see
Assign User to User Group.

12. You can also click on Close button to close the window, it will ask you "Do you want to
save changes" Press "OK" to Save or Cancel to exit without saving. If you click "OK", it
will take you to the Cart Settings page.

Deactivating User

Introduction

This functionality allows you to deactivate a single user or multiple users:

Procedure

Complete the following procedure to deactivate users.

1. Log into the CartWatch.

2. Onthe Home page, under Manage Users tab, click User.
3. The User Settings page displays.
4

Select the users that you want to deactivate and click Deactivate User button at the
bottom of the page.

5. It will ask for confirmation "Are you sure you want to de-activate the user(s) ". If
you click Yes, the selected users would be de-activated and you will get a
confirmation message "Deactivated Successfully"”.
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Managing Users

Assigning User Groups

Introduction

This functionality allows you to assign users to User Groups. You can assign a single
user to the User Groups or you can select all the users and assign it to the respective
User Groups.
Procedure
Complete the following procedure to assign user groups.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click User.
3. The User Settings page displays.
4

Select the user that you want to assign to the user group and click on Assign User
Group button at the bottom of the page.

5. Assign Users to User Group screen displays. It is divided into two vertical sections.

o Active Users

o User Groups

Figure 34: User to User Group Mapping

You can drag the Users to the User Groups to which you want to assign.



Managing Users

6. If you want to assign all the Active Users, select the [ selectall check box and drag
them to the required users.

Note: If a user is already assigned to a user group, you cannot assign it again.

7. Click Close to close the window. It will ask you "Do you want to save changes" .Press
"OK" to Save or Cancel to exit without saving.

Assigning Carts/Cart Groups

Introduction

This functionality allows you to assign users to carts or carts groups.

Procedure
Complete the following procedure to assign a cart to a cart group.
1. Log into the CartWatch.
2. Onthe Home page, under Manage User tab, click User.
3. The User Settings page displays.
4

Select the user that you want to assign to the cart or cart group and click on Assign
Carts/Cart Groups button at the bottom of the page.

5. Assign Users to Carts/Cart Groups screen displays.

Figure 35: Assign Users to Carts Cart Groups
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Managing Users

The screen is divided into three vertical sections:

e Active Users
e Cart Groups
e Carts

You can select the entire Active Users Group for assigning it to the Cart Group or you

can select a particular user and drag it to the Cart Group or the Carts to which you need
to assign.

Note: If a user is already assigned to a Cart Group or Carts, you cannot assign it again.

6. Click Close to close the window. It will ask you “Do you want to save changes". Press
"OK" to Save or Cancel to exit without saving.

Introduction

This functionality is used to print the user list details like User ID, User Name, Employee
ID, Access Code, Narc Access, Narc Code, User Type etc

Procedure
Complete the following procedure to print the cart details.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click User.
3. The User Settings page displays.
4. Click on the Print button at the bottom of the page.
5

The application displays the list of the user details.

Click on the Print icon that appears at the top of the page.

7. Click Close to close the window.
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Managing User Groups

Introduction

This functionality is used for the management of users groups. It lists all the
available users groups in the system and provides options to sort, filter, add, edit or
delete the users.

Tasks include:
¢ Adding a user group
¢ Editing user group
¢ Removing user group
e Assigning users

o Assigning carts/cart groups to users.

Adding User Groups

Introduction
This functionality allows you to add User Groups. You have to enter the details like
Group Name and Description for adding a User Group.
Procedure
Complete the following procedure to add the user group.
1. Log into the CartWatch.
2. Onthe Home page, under Manage User tab, click on User Group.

3. Manage User Group screen gets displayed.
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Managing User Groups

Figure 36: Manage User Group
4. Click on the Add User Group button at the bottom of the page.
5. The Add/Edit User Group window displays.

Figure 37: Add/Edit User Group



Managing User Groups

6. Enter following details for adding a user group.

Note: Fields marked with an asterisk * sign are mandatory.
e Group Name
e  Group Description

7. Click on the Next button after entering the details. The CartWatch saves the user
group to the database and you are taken to the next screen Assign User to User
Group. For instructions, see Assign User to User Group.

8. You can also click on Close button to close the window. It will ask you." Do you
want to save changes". Press “OK" to Save or Cancel to exit without saving. If you
click "OK", it will take you to the Manage User Group page.

Editing a User Group

Introduction

This functionality allows you to edit the existing details of the user groups. You can edit a
single user group or multiple user groups depending upon your requirement.

Procedure
Complete the following procedure to edit a user group.
1.  Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click User Group.
3. Manage User Group page gets displayed.
4

Select the user group that you want to change the details on and click Edit User
Group button at the bottom of the page.

5. The Add/ Edit User Group page displays.
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Figure 38: Edit User Group

You can edit the following fields:
e Group Name

e Group Name

Note: Fields marked with an asterisk * sign are mandatory

6. Click on the Next button after you finish making changes. The CartWatch saves the changes and
you are taken to the next page Assign Users to User Group. For instructions, see Assign Users

to User Group.
7. You can also click on Close button to close the window, it will ask you "Do you want to save

changes". Press "OK" to Save or Cancel to exit without saving. If you click "OK", it will take you
to the Manage User Group page.



Managing User Groups

Edit Multiple User Groups Simultaneously
Complete the following procedure to change multiple users’ details.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click User Group.

3. The Manage User Group page gets displayed. Select the user groups that you want to change
the details on and click Edit User Group button at the bottom of the page.

4. The Add/ Edit User Group(s) page displays.

Click on the Next button after making the changes. The CartWatch saves the changes and you
are taken to the next page Assign User to User Group. For instructions, see Assign User to

User Group.

6. You can also click on Close button to close the window, it will ask you "Do you want to save
changes" Press "OK" to Save or Cancel to exit without saving. If you click "OK", it will take you to
the Manage User Group page.

Remove User Group

Introduction

This functionality allows you to delete a single user group or multiple user groups.

Procedure

Complete the following procedure to remove users.

Log into the CartWatch.

On the Home page, under Manage Users tab, click User Group.

Manage User Group page displays.

A e b=

Select the users groups that you want to remove and click Remove User Group button at the
bottom of the page.

5. It will ask for confirmation "Are you sure you want to delete user groups ". If you click OK, the
selected user groups would be deleted and you will get a confirmation message "Removed
Successfully".
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Assigning User Groups

Introduction

This functionality is used to assign users to the user groups. You can assign a single user or
multiple users to the user groups depending upon your requirement.

Procedure
Complete the following procedure to assign user groups.
1. Log into the CartWatch.
2. Onthe Home page, under Manage Users tab, click User Group.

Manage User Group page displays. Select the user group that you want to assign to the users
and click on Assign Users button at the bottom of the page.

4. Assign Users to User Group screen displays. It is divided into two vertical sections.

o Active Users

o User Groups

Figure 39: User To User Group Mapping
You can drag the Users to the User Groups to which you want to assign.

Note: If you do not select a user and click Assign User button, you get an alert message
“‘Please select any group".



Managing User Groups

5. If you want to assign all the Active Users, select the [ selectall check box and drag them to
the required users.

Note: One user can be assigned to multiple groups.

6. Click Close to close the window. It will ask you "Do you want to save changes" Press "OK" to
Save or Cancel to exit without saving.

Assigning Carts/Cart Groups

Introduction

This functionality is used to assign user groups to the Carts or Cart Groups.

Procedure
Complete the following procedure to assign a cart to a cart group.
1. Log into the CartWatch.
On the Home page, under Manage User tab, click User Group.

Manage User Group page displays. Select the user that you want to assign to the cart or cart
group and click on Assign Cart Group button at the bottom of the page.

4. Assign Users to Carts/Cart Groups screen displays.

Figure 40: Assign Users/User Groups To Carts/Cart Groups
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The screen is divided into three vertical sections:
e User Group
e Cart Groups

e Carts

You can select a single User Group for assigning it to the Cart Group or the carts or you

can select multiple user groups and then drag them to the Cart Group or the Carts to
which you need to assign.

Note: If you try to assign a user group that is already assigned to a cart group or cart, you get
an alert message "User Group already exists".

5. Click Close to close the window. It will ask you “Do you want to save changes”. Press "OK" to
Save or Cancel to exit without saving.
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My Profile

My Profile

Introduction

This functionality allows the logged in user to view the details like User Name, Access
Code, Cart Access, User Groups, Narc Access, Extended ID, Assigned Cart, Narc Code,
Employee ID etc.

Procedure
Complete the following procedure to view the details of the logged in user.
1. Log into the CartWatch.
2. Onthe Home page, under Manage User tab, click on My Profile.

3. My Profile screen gets displayed.

Figure 41: My Profile

e User Name: This is the name of the user with which you have logged in. You
can edit its value. If the User Name is global, you cannot modify its value.
(Maximum 25 characters)
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e Password: You can edit its value.(Maximum 25 characters)
o Confirm Password: Re-enter your password. (Maximum 25 characters).
e Access Code: Itis the code to access the cart. You cannot change its value.

e Narc Access: This is the permission to access the Narcotics drawer. This
option will be disabled if you do not have permissions to change Narc
settings.

e Narc Code: This is the code to access the Narcotics drawer. This will be
disabled for all the users. You cannot change its value.

e Cart Access: There are two types of cart access: General and Specific. You
cannot change the value of Cart Access.

o Extended Id: You can enter your physical card access ID in this field. You
can change its value. (Maximum 16 digits).

o Description: This is the description about the user. You can change its
value.(Maximum 500 characters).For example, you can change the
description of the logged in user.

You can click on the User Group icon “— to view all the User Groups which
are assigned to this user.

Click Assign Carticon “— to view all the assigned carts to this user.

o Click Reset Access Code button, If you want to reset the access code, the
reset code gets refreshed and you get a message Code updated
successfully.

o Click Reset Narc Code button, If you want to reset the Narc code, the reset
code gets refreshed and you get a message Code updated successfully.

4. Click on Save button after making the changes. The information is saved and you
get a confirmation message “User is updated Successfully”.

5. Click Close to close the window without saving the information.
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Send Changes

Introduction

On selection of the Send Changes button, the following tasks are performed by the
application.

e Cart details will be updated in the actual cart.
e User details will be updated in the actual cart.

e If new users are added, they will be added to the actual cart and if any users
are removed they will be removed from the actual cart.

¢ If any modification has been done in the details of the user it will be updated in
the actual cart.

Send Changes

Procedure
1. Log into the CartWatch.
2. Onthe Home page, under Update tab, click on Send Changes.

3. Send Changes screen gets displayed.
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Figure 42: Send Changes
If you click on Send Changes button through the wizard.

(For example, Edit a cart ->Click on Next button ->Assign Carts to Cart Groups - Click on Next button -
->Assign Users/ User Groups to Carts-->Click on Next button->Send Changes).

In this scenario, changes of only that cart will be updated in the actual cart that you have selected for
editing.

Otherwise, if you are not going through the wizard and directly click on Send Changes button on the
Home page, all the cart and the user details across the application will be updated in the actual cart.



11
Roles and Permissions

Introduction

Roles are the level of general access assigned to any user in the CartWatch application.
Roles can be filtered on the basis of user type. For example:

= RMSGIlobal role: Users who have rights to all functions and can make all
changes to the carts and user settings for all of the carts and users in the
database.

= RMSLocal role: Users who have access to only a limited number of carts, but
can make all changes related to the carts and users they manage.

Permissions are used to further restrict access to user roles. For example, if a user’s role
is Local, you can limit the cart and user settings that the user can change, by not
providing the editing rights to the user for specific actions.

If you have the permissions to view all the menu items of the home page then only you
would be able to view the items. For example, if you do not have the View permissions of
Manage User and Manage Cart group you will not be able to view those links on the
home page. You can assign permissions to the newly created role or at the time of
editing the role.

Tasks include:
o Adding a Role
o Editing a Role
o Removing a Role

o Managing Permissions

Adding a Role

Introduction

This functionality allows you to add a new role. When you create a new role you can copy
the roles and permissions of any existing role or you can add a new role and assign the
permissions that are required for that role.

If any user or group needs special permissions other than defined in default roles,
administrator can create new roles and assign users to that new role.
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Roles and Permissions

Procedure
1. Log into the CartWatch.
2. On the Home menu, click on Manage Roles.

3. Manage User Roles/Permissions screen gets displayed.

Figure 43: Manage User Roles and Permissions
4. Click on the Add Role button. ADD/Edit Roles screen displays.

Figure 44: ADD/Edit Role



Roles and Permissions

5. You have to enter the following fields.

¢ Role Name: This is the name of the role. Role name must be unique for each role.
(Maximum 100 characters.)

o Description: This is the description about the role. (Maximum 1000 characters)

e Copy Role: This field contains the list of roles. If you select any role it would copy
the permissions of that role and on creation of new role all copied permissions are
assigned to that new role. If you do not want to copy the role, select None form the
list.

6. Click on the Next button after entering the details. The information is saved and you are taken to
the Manage Permissions page. For instructions, see Managing Permissions page.

6. Click Close to close the window. It will ask you “Do you want to save changes".
Press "OK" to Save or Cancel to exit without saving.

Editing a Role

Introduction

This functionality allows you to modify the details of a role. You can modify the details like
name, description and the permissions assigned to a role.

Procedure

Complete the following procedure to edit a role.
1. Log into the CartWatch.
On the Home menu, click on Manage Roles.

2

3. Manage User Roles/Permissions screen gets displayed.

4. Select the role that you want to modify and click Edit Role button.
5

The Add/ Edit Roles page displays.

Figure 45: Edit Role
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Note: Fields marked with an asterisk (*) sign are mandatory.

6. You can modify the following fields:

e Role Name
e Description

8. Click on the Next button after you finish making changes. The CartWatch saves the changes and
you are taken to the next page Managing Permissions. For instructions, see Managing
Permissions.

9. You can also click on Close button to close the window; it will ask you "Do you want to save
changes". Press "OK" to Save or Cancel to exit without saving.

Removing a Role

Introduction

This functionality allows you to delete the roles.

Procedure
Complete the following procedure to remove users.
1. Log into the CartWatch.
2. On the Home menu, click on Manage Roles.
3. Manage User Roles/Permissions screen gets displayed.
4. Select the role which you want to delete and click Remove Role button
5

It will ask for confirmation "Are you sure you want to remove ". If you click “OK”,
the selected role would be deleted and you will get a confirmation message "Role
removed successfully”. If the role is attached to any user, that user will be moved
to Local Role and the role will be removed.

6. You cannot remove RMSGlobal & RMSLocal roles.



Roles and Permissions

Managing Permissions

Introduction

Permissions are used to further restrict access to user roles. For example, if a user’s role
is RMSLocal, you can limit the cart and user settings that the user can change, by not
providing the editing rights to the user for specific actions.

When the CartWatch is installed on your system, RMSGlobal and RMSLocal roles are
created with predefined set of permissions.

If you are having the permissions to view all the menu items of the home page then only
you would be able to view the items. For example, if you do not have the View
permissions of Manage User and Manage Cart group you will not be able to view

those links on the home page. You can assign permissions to the newly created role or at
the time of editing the role.

You can assign permissions at the time of adding a new role or editing an existing role.

For example, edit a role and then assign permissions to it.

Procedure
Complete the following procedure for managing permissions.
Log into the CartWatch.
On the Home menu, click on Manage Roles.
Manage User Roles/Permissions page gets displayed.
Select the role that you want to edit and click Edit Role button.

The Add/ Edit User Group page displays.

2L S o

Click on the Next button after you finish making changes. Manage Permissions
page displays.
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Figure 46: Manage Permissions
The upper part of the screen contains the information about the role and its description.
The lower part of the screen shows the permissions that you can assign to this role
You can assign the permission to the user for either editing or viewing OR both.

For example, if you want that user should have the cart access permission for both
editing and viewing. Select the Edit and View check box against the given permission.

7. Click Close to close the window It will ask you "Do you want to save changes™
Press "OK" to Save and Cancel to exit without saving. If you click "OK", it will take
you to the Manage User Roles/ Permissions page.
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Import and Export Users

Introduction

This functionality is used to import users into the application using comma separated
CSV file. CSV file structure is fixed and fields must be in same order. Once you browse
the CSV file, first record from the file will be displayed in the fields of right hand side so
that sequence of the fields can be checked. While importing users, if any user import fails
because of constraints or any other reason, information about user is logged into log file
and at the end of import, summary is displayed with imported users and failed users.

Tasks include:
e Import Users

e Export Users

Import Users

Introduction

Procedure

[

CAPSASOLUTIONS' |

This feature is very useful as it enables to create users in bulk and you do not have to
add users one by one. You have to create one CSV file where details of the users are
given as per the format. When this CSV file is imported into the system all the users that
are given in the CSV file are created in the system. If the details given of the user are not
as per the format the application displays an alert message User import failed and
would specify the reasons why it failed.

If narcotics access information does not exist in import file then the Default Narcotics
access that you have selected is used as default for those records.

Narcotics access in import file always takes precedence and overrides default access.

Complete the following procedure to import the users into the system.
1. Log into the CartWatch.
2. On the View menu, click Import Users.

3. The application displays the Import Users screen.
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Figure 47: Import Users

On right side of the screen, you will see the following fields. For understanding the terms
please refer ADD User section

e User Name: (Maximum 25 characters). For example, Sarika123

e Access Code: (4, 5 or 6 digits). Must be the same length for all users. For
example, 653432

e Narc Access: It has the following options: None, Drawer1, Drawer2, and Drawer
1&2.

e Narc Code: (4 digits access code). For example, 4455

e Extended Id: (Maximum 16 digits). For example, 895623

o Employee Id: (Maximum 16 characters). For example, Michael 123

e User Type: You can have either a local, global or a user defined user types.
e Active: It has two options: 1 and 0. 1 stands for yes and 0 for No

e Override: It has two options: 1 and 0. 1 stands for yes and 0 for No

e Password: (Maximum 30 characters.)

e Records in File: it shows the total number of records in the file.
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4. Click on the Browse button. It is used to import the CSV file. You can select the file
to import that contains the new user details. On File selection application populates
the fields from the first row of the file on Right hand side fields. You can verify the
sequence of the fields in the file.

5. Click on the Import button after selecting the Import file. The application displays the
Import Summary.

Figure 48: Import Summary

Users are imported into the system and if the information of any user is not correct that
user is not imported and the reason of failure is displayed in the lower half.



Import and Export Users

Export Users

Introduction

This option is to export users of the system (including defaults) in a comma delimited text
file. Format or the field sequence of the text file should match with import users so that
same file can also be used to re-import users into the system.

Procedure
Complete the following procedure to export the users into the system.
1. Log into the CartWatch.
2. On the View menu, click Export Users.

3. The application displays the Export Users screen.

Figure 49: Export User

4. You can export the users on the basis of roles selected from the list or the Group
Names. You have to give a proper name to the file which you want to export

5. The application will provide you the option whether you want to open or save the file.
You can open or save the file depending upon your requirement.
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Activate Users

Introduction

This functionality is used to activate deactivated users into the system. This option is
available to you when you search for deactivated users in the application.

Procedure

Complete the following procedure to activate the users into the system.
1. Log into the CartWatch.
2. On the View Users menu, click Deactivated Users.

3. The Deactivated Users screen displays.

Figure 50: Deactivated Users
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4. You can arrange the users in ascending or descending order by clicking on the User
Name link. If you want to select all the users, select the check box against the

User Name
UserName . In this case, all the users that have
been deleted get selected.

5. Click on Activate Users button.

You can even select a particular user which you want to activate. The application
asks for confirmation "Are you sure you want to activate users". If you click OK,
all the selected users will become active and will no longer appear in the
Deactivated Users list and the message "Users Activated Successfully” will
appear on the screen.
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Activate Carts

Introduction

This functionality is used to activate deactivated carts into the system. This option is
available to you when you search for deactivated carts in the application.

Procedure

Complete the following procedure to activate the carts into the system.
1. Log into the CartWatch.
2. On the View Carts menu, click Deactivated Carts.

3. The Deactivated Carts screen displays.

Figure 51: Deactivated Carts
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4. You can arrange the Cart Names in ascending or descending order by clicking on
the Cart Name link. If you want to select all the carts, select the check box
) [] cartName ,
against Cart Name. All the carts which have been deleted get
selected.

Click on Activate Carts button.

You can even select a particular cart that you want to activate. The application asks
for confirmation "Are you sure to activate". If you click OK, all the deleted carts will
become active and will no longer appear in the Deactivated Carts list and the
message "Carts Activated Successfully" will appear on the screen.
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Failed User Update

Introduction

This functionality allows you to view the details of the failed users.

For example, if you have made some changes in the Users like changing the User Name,
User Code or the password. These changes need to be updated in the actual carts but in
case for any reason these changes fail to take place on the actual carts they get
displayed in Failed User Updates.

Procedure

Complete the following procedure to view the failed user update.
1. Log into the CartWatch.
2. Onthe View Users menu, click Failed Users Updates.

3. The Failed Users Updates page displays.

Figure 52: Failed User Update
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4. You can view the details of the users like User Id, User Name, Failed User Details,
Sync Date and Time in the tabular format. In case, no user is present, the application
displays the message "No Record Found".

5. Click on Sync Now button, the application tries to overwrite the changes in the actual
cart and if it gets updated on the actual cart the details would be removed from the
Failed User Updates screen.

6. Click on the Print button if you want to print the displayed failed user details.
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Failed Cart Update

Introduction

This functionality allows you to view the details of the failed carts.

For example, if you have made some changes in the Carts like changing the Cart Name
or other settings. These changes need to be updated in the actual Carts but in case for
any reason these changes fail to take place on the actual Carts they get displayed in
Failed Carts Updates.

Procedure

Complete the following procedure to view the failed cart update.
1. Log into the CartWatch

2. Onthe View Carts menu, click Failed Carts Updates.

3. The Failed Carts Updates page displays.

Figure 53: Failed Carts Updates
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4. You can view the details of the carts like Cart Id, Cart Name and Failed cart details,
Sync Date and Time in the tabular format.

You can arrange the Cart Id's in the ascending or descending order by clicking on
Cart Id

link.

You can arrange the Cart Name's in the ascending or descending order by clicking on

Cart Name .
- link.

In case, no cart is present, the application displays the message "No Record Found".

5. Click on Sync Now button, the application tries to overwrite the changes in the actual
machine and if it gets updated on the actual machine the details would be
removed from the Failed Carts Updates screen.

6. Click on the Print button if you want to print the displayed Failed Cart details.
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System Settings

Introduction
This functionality covers all major system settings required to function and run CartWatch
application smoothly. Settings will be done by administrator at the time of installation.
Settings can also be changed if some changes occur at the application level or at the
server level. For example, if your server name, database name or the password gets
changed you can make the changes in the System Setting screen to update the
changes.

Procedure

Complete the following procedure to change the system settings.
1. Log into the CartWatch.

2. On the Home menu, click System Settings. The application displays the System
Settings page.

Figure 54: System Settings
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System Settings

Note: Fields marked with an asterisk(*) sign are mandatory

o Application Path: Path where application is stored on the system. It is not
editable.

o Database Server Name: Name of the server where database is hosted. You
can edit its value.

e Database Name: Name of the database. You can edit its value.

e Db Username: Name of database user which will be used for db
connection.(Maximum 50 characters). You can edit its value.

e Db Password: Password of db user. (Maximum 50 characters). You can edit
its value.

o Verify Password: Password that you enter in this field should exactly match
the password that you have entered in Db Password field.

e If the password that you have entered does not match with the DB Password
field, you will get a message Password and Confirm Password should
match.

e Log Read Time: This setting is for automatic log file retrieval from carts. Log
files will be retrieved at specified time. Format HH: MM (HH for hours and
MM for minutes.) For example, 5:40.

e Log Interval (in hours): This is the interval for log file retrieval. For example,
if the log time is 5:40 and the log interval is 48 hours, then every 48 hours at
5:40 the CartWatch attempts to read the log records. (Maximum 3 digits). For
example, 124

e Log Archive Interval (In hours): This is the interval for logs to be archived
which are to be sent to a different database table and same could be deleted
from the existing event log table depending upon the user’s choice.
Maximum 3 digits. For example, 128.

e Login Mode: You can select the Login mode from the list.

e Language: You can select any language at the time of installation from the
given options: English, French and Spanish. For example, if you have
selected English language at the time of installation, you cannot change it to
French or Spanish afterwards.

o Access Code Digits: This setting specifies access code length in the
system. You have three options in the list: 4, 5 and 6. For example, if you
have selected 4 then you cannot enter 5 or 6 digits access code while adding
user or cart. If you change Access Code digit to any value greater than 4 you
cannot change it to less than the selected value although it can be reset to
value greater than the selected value.

3. Click on the Save button after making the changes. Your data will be saved and you
will get a message of "Data updated successfully".

4. Click on the Close button, if you do not want to save the changes. You are directed
to the Home page.
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Troubleshooting

It is a logical search for the cause of a problem so that it can be solved, and so the application can be
made operational again.Troubleshooting is needed as the problem can have many possible causes.

Tasks include:
e Troubleshooting Install Errors
e Troubleshooting Network Errors
e Troubleshooting Database Errors

Given below are the steps for troubleshooting the Install, Network and Database errors.

Troubleshooting Install Errors

1. During Installation the following Error Can Occur

An error has occurred while establishing a connection to the server. When connecting to SQL
Server 2005, this failure may be caused by the fact that under the default settings SQL Server
does not allow remote connections.

Troubleshoot
e Enable remote connections for SQL Server 2005 Express or SQL Server 2005 Developer Edition

¢ You must enable remote connections for each instance of SQL Server 2005 that you want to
connect to from a remote computer.

Follow the steps given below for performing the given task.

e Click Start >> Programs >> Microsoft SQL Server 2005 >> Configuration Tools >>click SQL
Server Surface Area Configuration.

e Onthe SQL Server 2005 Surface Area Configuration page, click Surface Area Configuration
for Services and Connections.

¢ On the Surface Area Configuration for Services and Connections page, expand Database Engine
>> click Remote Connections >> click Local and remote connections >> click the appropriate
protocol to enable for your environment >> click Apply.

Note: Click OK when you receive the following message:
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Troubleshooting

Changes to Connection Settings will not take effect until you restart the Database Engine
service.

o On the Surface Area Configuration for Services and Connections page, expand Database
Engine >> click Service >> click Stop, wait until the MSSQLSERVER service stops and then click

Start to restart the MSSQLSERVER service.

2. During Installation the following Error can occur when you provide wrong username and Password
to connect to SqlServer.

Troubleshoot
e Check whether the username and password that you have provided are genuine.

Figure 55: Login Error
e By logging into Sqgl Server 2005 by using the same username and password.

e If you can login into Sql Server 2005 but not able to run RMS Setup by using the
same username and password then contact your system administrator.

3. During Installation of RMS. If you choose the option migrate your old data into new database and
provide wrong Database name which is not existing the following error occurs:

Setup failed during migrating your old data into new database.

Troubleshoot
o Check whether the Database name you provided is right database that exists in your

Same Sql Server 2005 where your new database created.

Figure 56: Setup Failed Error
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Troubleshooting
o If the Database name you provide exists then check it's the old database that is used by
earlier Artromick Application.

o If all the information provided by you is correct but still error occurs contact your System
Administrator.

4. |If the following error occurs during Installation of RMS.

Setup is not able to locate the IIS (Internet Information Server) installed on the machine. Please
install IIS before continue to setup.

Troubleshoot
¢ Install IS before continue to Install RMS Setup.

o Check whether the IIS is installed on your machine by clicking the C: drive and then
checking in C drive whether the Inetpub directory exists or not and in Inetpub directory
the wwwroot sub directory exists or not.

o If the wwwroot directory does not exist then install IS before Install RMS Setup.

5. After Successful Installation of RMS Setup the following error can occur when you type the URL of
RMS Application in the address bar. .

(http://localhost/CartWatch/Webforms/login.aspx)

Server Error in '/CartWatch' Application .The resource cannot be found.

Description: HTTP 404. The resource you are looking for (or one of its dependencies) could
have been removed, had its name changed, or is temporarily unavailable. Please review the
following URL and make sure that it is spelled correctly.

Requested URL: /CartWatch/Webforms/login.aspx

Troubleshoot

Cause: - The main Cause of this Error is due to the physical path of application as it is not
attached to the Virtual Directory in IIS.

Steps to attach physical path to Virtual Directory
¢ Open lIS manager by entering inetmgr in windows Run command.

e Drill down to Default Website.



Troubleshooting

Figure 57: Search Virtual Directory

e Under Default Website find the virtual directory i.e. CartWatch.
¢ Right click on virtual directory i.e. Cartwatch and click on properties tab.
e Under the Virtual Directory tab you will find Local path text box and browse button.

o Use the Browse button and locate the physical path where your Application is
installed.

Figure 58: CartWatch Properties
e Click Apply button after choosing the physical path where your Application installed.
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Troubleshooting

Troubleshooting Database Errors

While login, If you receive error “Unknown error occurred”, please contact your Administrator”.
Check if you are connected to correct database.

Verify the Database Server Name, Database name & credentials in connection string of
web.config file. Web.config file is inside the CartWatch installation directory

Following is the key to connect the database in configuration file:-

<add key="ConnectionString" value="Database=RMS_LIVE; Server=RSI-NOD-
SQL2K5\GENACIS; Integrated Security=False; User Id=CAPSA; Password=CAPSA,;
timeout=240; MultipleActiveResultSets=true" />

Where Database is the database name, server is the IP or machine name of the machine where
database is resided. UserlD and Passwords are the credentials to access the database. While
making changes please make sure you don’t change the format of the connection string.

Troubleshooting Network Issues

If you are unable to connect to the CartWatch application. Check if you are able to access the IP
of machine of CartWatch application. You can check the same by pinging the machine IP or
name using “Start >> Run”. Type “ping <machinelP> —t” or “ping <machinename> —t” for example
if the URL of CartWatch application is :

http://10.131.60.221/CartWatch/webforms/login.aspx or
http://MachineName/CartWatch/webforms/login.aspx

You can check by command “Ping 10.131.60.221 —t” or “Ping MachineName —t”

It will open a command prompt window and will show the response. If the response is “Request
Timed out”, please check with your administrator to access the machine.
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